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     「第八屆調查研究方法與應用國際研討會」 
徵稿啟事 

 會議時間及地點 

 時間：2008 年 9 月 11 日、12 日（星期四、五） 
 地點：中央研究院人文社會科學館 國際會議廳 

 說明 

本國際研討會歡迎任何和不完整調查資料的處理及分析、抽樣及加權、面訪電

訪網路等各種調查方法或整合、問卷設計、地理資訊應用、其他調查研究相關議題

的論文。 

本次會議除安排 Roger Tourangeau 教授(University of Michigan)的大會專題演

講及一般論文發表外，亦安排四場專題演講，邀請的國際重要學者包括(依姓氏排

序)：Couper, Mick P. (專題演講) (University of Michigan)、Harkness, Janet (專題演講) 
(University of Nebraska-Lincoln)、Johnson, Timothy Patrick (University of Illinois at 
Chicago)、Raghunathan, Trivellore E. (University of Michigan)、Yeung, Wei-Jun Jean 
(New York University) 、 Zhou, Xiao-Hua Andrew ( 專題演講 ) (University of 
Washington)。 

 投稿須知 
 論文摘要 600 字以內，包括五個以內的關鍵詞（Word 或 PDF 格式）。  
 請同時附上通訊作者簡歷（Word 或 PDF 格式）。  
 論文摘要採網路投稿方式  
 歡迎以英文寫作，增進國際學術交流。 

 重要日期 
 摘要截稿日期：2008 年 5 月 30 日  
 是否接受通知日期：2008 年 6 月 16 日（以 email 個別通知）  
 全文截稿日期：2008 年 8 月 10 日  

 聯絡方式 
 聯絡人：謝芮桓 小姐  
 地 址：中央研究院人文社會科學研究中心調查研究專題中心 

             115 台北市南港區研究院路二段 128 號  
 電 話：(02)2788-4188 分機 506 ；傳 真：(02)2788-1740  
 Email: srcsr@gate.sinica.edu.tw； 
 網址：http://www.sinica.edu.tw/as/survey/2008/  
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資料釋出消息 
邱亦秀 

「學術調查研究資料庫」於 96 年 12 月至 97 年 2 月間開放釋出及改版更新訊息： 

【大型學術調查】 

 「台灣地區社會變遷基本調查」第五期第二次資料開放 

計畫主持人：傅仰止 
計畫執行單位：中央研究院社會學研究所 
經費補助單位：行政院國家科學委員會 
計畫執行期間：2006/01/01－2006/12/31 

臺灣地區社會變遷基本調查是由行政院國家科學委員會人文社會科學發展處

在 1983 年推動，由社會科學界研究人員規劃執行。調查的主要目的在經由抽樣設

計收集調查資料，，提供學術界進行有關社會變遷之研究分析。在基本調查研究的

設計上，是以間隔五年為原則，從事貫時性之調查，以集得可做兩個時間點以上之

比較分析的資料，達到探究社會變遷的重要目標。到目前為止，已完成 37 項全台

地區抽樣調查。 

本年度調查依例分成兩個題組，「家庭」組係該主題的第四次調查，除了針對

過去三期延續性題目做通盤評估外，並加入第一次東亞社會調查題組合併成「家庭

組」問卷，成功訪問樣本數為 2,102 人，問卷題組包括：基本狀況、家庭背景、代

間關係、家人評估、家庭、婚姻與性別角色、家庭價值、擇偶史、夫妻關係、社會

階層與文化價值等。 

「公民與國家」組則為新主題，不但加入 2006 年國際社會調查計畫「政府角

色」題組，並參考臺灣目前重要的國家與公民議題，設計適合臺灣情況的題組，包

括：日常生活與全球化、經貿發展、政府角色、廉能國家、社會保障、資訊風險、

家庭與個人狀況等題組，共完成 1,972 份成功訪問問卷。 

釋出項目計有：問卷檔、原始數據資料檔、SPSS 資料檔、STATA 資料檔、欄

位定義程式、次數分配表、與研究報告書。 

 「台灣社會變遷基本調查」新增釋出權數檔 

社會變遷計畫小組與調查研究專題中心基於服務使用者進行資料推估之需

求，著手進行資料權數的的計算工作，已於日前完成一期一次至四期五次的權數計

算，即日起對外開放，同時亦解除該資料的下載次數限制，SRDA 會員如有使用需

要可以隨時登入下載。 

新增釋出項目為：SPSS 權數資料檔、加權說明檔。 



 
3 

 

 華人家庭動態資料庫的建立：第八年計畫（RR2006 ＆ CIV2006）資料開放 
計畫主持人：簡錦漢教授 
計畫執行單位：中央研究院人文社會科學研究中心華人家庭研究計畫 
經費補助單位：中央研究院人文社會科學研究中心、 

行政院國科會社會科學研究中心 

  「華人家庭動態資料庫」（Panel Study of Family Dynamics，PSFD）以家庭為

基本單位的大型追蹤調查計畫，第八年的資料包括主樣本問卷（RR2006）及子女

樣本問卷（CIV2006）皆已對外公開，歡迎國內外學術界人士多加利用。 

主樣本問卷包括生活與工作狀況、居住安排、家庭決策與收支、家人互動關係、

子女生育與教養等題組；子女樣本問卷訪問內容為個人資料、教育經驗、工作經驗、

婚姻與配偶資料、居住安排、家庭決策與收支和宗教信仰等主題。 

該項調查計畫資料釋出的項目計有：問卷檔、過錄編碼簿、SPSS 資料檔、Stata
資料檔、ASCII 資料檔、SAS 欄位定義程式、次數分配表。 

 「台灣高等教育系統之建置與運用」資料開放 
計畫主持人：彭森明 
計畫執行單位：國立台灣師範大學教育評鑑與發展研究中心 
經費補助單位：行政院國家科學委員會                 

本計畫旨在建立完整和全面性的台灣高等教育資訊系統，為求資料的完整性，

資料庫涵括各大學校院特質與狀況、經費、校園環境設備、課程、校園文化、教職

員素質、各科系在校學生素質和學習行為表現、各學門畢業生及畢業後的發展等。

這些豐富的資料以及分析所得之教育指標、研究報告和統計數字等，不僅有助政府

作決策、各校院自我評鑑和自我改進、學生學習成長和發展，更可以提升高等教育

研究品質，對提升高等教育研究與教學以及促進高等教育卓越，將有極大的助益。 

釋出資料詳細內容請參考本期「台灣高等教育資料庫簡介」一文，釋出項目計

有：問卷檔、SPSS 資料檔、過錄編碼簿、次數分配表、研究報告書。 

 「台灣教育長期追蹤資料庫」公共使用版資料更新及開放 
計畫主持人：張苙雲教授 
計畫執行單位：中央研究院社會學研究所 
經費補助單位：教育部、中央研究院 

行政院國家科學委員會、國家教育研究院籌備處  

  「台灣教育長期追蹤資料庫」（Taiwan Education Panel Survey，簡稱 TEPS）
係由中研院、教育部、國科會和國家教育研究院籌備處共同規劃之全國性、長期性
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的調查研究計畫，以問卷調查方式，向國中、高中、高職及五專學生收集資料，再

以這些學生為核心，擴及瞭解影響學生學習經驗的幾個最主要因素，如家長和老師

等。 

資料更新：綜合分析能力 

    此次更新第一波、第二波和釋出第三波公共使用版的綜合分析能力資料，更新

內容主要是重新命名變項名稱，以符合可四波對照的題項對照表。 

資料開放： 
新釋出第三波公共使用版老師資料和第三波限制使用版資料，限制使用版資料

為教師問卷與班級評量，可與公共使用版的學生問卷、學生評量和家長問卷進行連

結。 

有關教育追蹤（TEPS）資料申請資格及申請辦法說明，請上網查詢。網址

http://srda.sinica.edu.tw/TEPS/index.aspx，或利用「學術調查研究資料庫」網頁

(http://srda.sinica.edu.tw)【大型學術調查】→【台灣教育長期追蹤資料庫】進入該網

頁。 

【政府抽樣調查】 

 「主計處人力運用調查」96 年資料開放 

行政院主計處為明瞭台灣地區勞動力運用、移轉及就業、失業狀況等短期變動

情勢，自民國 67 年起即於每年 5 月隨同人力資源調查（前為勞動力調查）附帶辦

理人力運用調查。調查內容以人力資源調查為基礎，並補充下列各項資料：(1)有偶

婦女勞動參與情形；(2)就業者工作時間、工作收入、現職在職時間、獲得現職方法

與工作變換情形；(3)失業者工作機會及希望待遇；(4)潛在勞力供應等。 

調查之地區範圍為臺灣地區，包括臺灣省、臺北市及高雄市，而以現住此一地

區內之普通住戶與共同事業戶戶內年滿十五歲，自由從事經濟活動之民間人口為對

象，但不包括武裝勞動力及監管人口。 

調查採派員實地訪查方式，由臺北市、高雄市暨臺灣省各縣市政府遴選調查員

擔任。抽樣母體以最近一年「台灣地區年終戶籍村里別統計資料檔」為抽樣母體。

採用「分層二段隨機抽樣法」，第一段樣本單位定為村里，而第二段樣本單位定為

戶。96 年共成功訪問 20,521 戶，合計 59,445 人。 

 開放資料的項目包含：資料檔（ASCII 與 Stata 格式）、SAS 以及 SPSS 程式、

問卷、過錄編碼簿以及資料整理報告。 
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 「主計處台灣地區社會發展趨勢調查」95 年家庭生活資料開放 

「社會發展趨勢調查」是由行政院主計處所規劃的全國性長期調查計畫，鑑於

社經情勢之急遽變遷，為掌握社會發展及國民生活之完整資訊，因應各界對了解當

前社會現況之需求，於 87 年度起著手規劃辦理。該調查計畫分「家庭生活」、「社

會參與」、「休閒文化(93 年改為時間運用)」及「健康安全」4 項主題，並採分年

循序辦理方式進行。各年度之調查資料，期可建立社會發展趨勢調查之長期時間數

列資料供各界參用。 

該調查計畫對象為居住於臺灣地區內之普通住戶及戶內本國籍之民間人口。抽

樣方法以臺灣地區戶籍登記資料為抽樣母體，採分層二段隨機抽樣方法，第一段抽

樣單位為村里，以比例機率抽樣法抽出，第二段抽樣單位為戶，以系統抽樣法抽出，

各統計指標係採戶數加權推計而得。 

此次釋出資料為「95 年家庭生活」調查，調查問卷分為家戶問卷及個人問卷兩

種，前者每戶填寫一份，訪問內容包括家中全員基本概況、設籍本戶但未共同生活

者概況、14 歲及以下就學及照顧概況、住宅及家事分工概況等；後者 20 歲及以上

成員每人填寫一份，訪問內容包括受訪者婚姻、工作、收入基本資料，以及親屬人

數和同住概況、生活概況、對婚姻的看法、婚姻和親子關係狀況等。 

開放資料的項目包含：資料檔、SAS 以及 SPSS 程式、問卷、過錄編碼簿以及

資料整理報告。 

申請政府抽樣調查資料請至 http://srda.sinica.edu.tw/govdb，依步驟填妥申請表

格及研究大綱，我們會在進行審核之後以 E-mail 通知領取資料。 

【出版品】 

 「調查研究資料整理與檢誤研習班」講義開放下載 

本年度調查研究專題中心主辦的「調查研究資料整理與檢誤研習班」已於二月

二十、二十一日圓滿落幕，感謝各界人士報名參加以及場地提供單位的協助。 

本次課程包括調查研究資料庫之簡介與應用、過錄編碼的設計概論、SPSS 使用

操作基本介紹，以及如何進行調查資料的整理與檢誤等，課程所使用的講義與範例

皆已放在「學術調查研究資料庫」網頁上，請有興趣使用者進入資料庫首頁後，於

左方選擇【相關資源】→【參考文件】，歡迎下載使用。 
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台灣高等教育資料庫  簡介 
蘇婉雯 

「台灣高等教育資料庫」之建置，是國科會及教育部支持的一項計劃，目前由

國立台灣師範大學「教學評鑑與發展研究中心」負責執行。該計畫旨在建立完整和

全面性的台灣高等教育資訊系統，涵括各大學校院特質與狀況、校園環境設備、課

程、校園文化、教職員素質、各科系在校學生素質和學習行為與表現、各學門畢業

生及畢業後的發展等。希望藉由這些豐富資料的建立，以及分析所得之教育指標、

研究報告和統計數字等達成以下目的： 

1. 提供教育決策人員可靠、正確、客觀而又能快速取得的資訊，做為決策之

依據； 
2. 提供校院主管辦學治校的資訊，做為行政規劃及教學改進之參考，藉此促

進大專校院卓越化，培育世界一流國民； 
3. 提供研究人員優質而又豐富的原始資料，進一步探討教育問題並做國際比

較； 

「學術調查研究資料庫」(以下簡稱 SRDA)取得「教學評鑑與發展研究中心」

授權 SRDA 會員使用的「台灣高等教育資料庫」92~94 年調查資料，已陸續開放會

員下載利用，這些調查資料包括對大一、大三（含四技三年級與二技一年級）、畢

業生以及教師的調查結果（表一）。 

  表一提供 SRDA 會員使用之「台灣高等教育資料庫」調查資料一覽表 

    資料名稱 /調查對象             學年度  

1 .學生調查資料：  

．大一新生  92、 94 學年度  

．大三、二技學生  92、 94 學年度  

．畢業生  91 學年度  

2 .教授調查資料  93 學年度  

其中，大三與二技學生 92 年學度的問卷調查結果合併為一個檔案，94 學年度

則為各自獨立之檔案。歷次調查資料檔皆包含全部抽樣樣本，因此資料檔中提供一

個變項，讓使用者據以判別各樣本為回收樣本、抑或是未回收樣本。 

茲將「台灣高等教育資料庫」研究方法上的特點說明如後。 

一、 調查母體 

由教育部協助發文至全國各大專校院，彙整各校大一、大三、畢業生、專任教

師（包括助理教授、副教授及教授）等基本資料檔，進行抽樣工作。 
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二、 抽樣方式 

除了 93 學年度專任教師與 94 學年度二技新生採普查的方式進行之外，其他學

生資料則採用「分層隨機抽樣法」，其步驟簡要說明於下： 

1. 依學校分層，計算各校應抽人數。 
2. 依學門分層(94 大一則依科系分層)，按各學門佔各校人數的比例隨機抽

樣。 
3. 依身份別分層，將殘障生及原住民全部抽出。 
4. 各校人數至少 100 人。 

相關母體及抽樣人數、調查與催收方式、以及施測時間等資訊，請參考表二。 

表二「台灣高等教育資料庫」調查設計對照表 

問卷名稱 母體資料 抽樣人數 回收人數 調查方式 催收方式* 施測期間 

91學年度畢業生 157 所，157,610 人 79,824 人 12,263 份

隨機分派為兩組，分

別進行網路調查、郵

寄書面問卷調查 
A 

93 年 8 月至 
94 年 1 月 

92 學年度大一 156 所，174,277 人 49,609 人 33,959 份 網路調查 B 93 年 3-8 月 

92 學年度大三、

二技 
140 所，164,725 人 48,899 人 30,272 份 網路調查 B 93 年 5-8 月 

93 學年度教師 156 所，43,205 人 
43,205 人

(普查) 
12,747 份

網路調查為主、亦提

供書面問卷 
C 94 年 3-9 月 

94 學年度大一 161 所，186,709 人 75,084 人 52,315 份 網路調查 
B 94 年 10 月至

95 年 2 月 

94 學年度大三 156 所，174,277 人 49,609 人 26,307 份 網路調查 
B 94 年 10 月至

95 年 2 月 

94學年度二技一

年級 
83 所，24,689 人 

24,689 人

(普查) 
15,036 份 網路調查 

B 
95 年 3-6 月 

*A.郵寄通知函，僅催收部分未回填之學生，共計催收兩次， 
B.多次以電子郵件催收未填學生，或請各校聯絡人協助通知學生上網填答。 
C.多次以電子郵件催收未填教師，並請各校聯絡人協助通知教師上網或由研究中心提

供紙本問卷填答。 

三、 權重說明 

為使回收樣本之分佈能與母體之分佈吻合，以確保回收者更具代表性，資料檔

中提供調整至母體人數或回收人數的權重供使用者利用： 

(一)權重種類 
1. 原始權重：抽樣比例的倒數。 
2. Final weight：依據回收比率調整原始權重（權重的總和會等於母體總數）。 
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3. Relative weight = Final weight ÷ Final weights 的平均數（權重的總和會等於回

收人數）。 

 (二)權重運用 
1. 使用 final weight 來估計母體人數（例如：有某個特質的學生人數）。 
2. 運用 final weight 於描述性統計分析。 
3. 運用 relative weight 於推論性統計分析與回歸分析。 

四、 問卷主題 

學生問卷調查主要是想瞭解大學生的受教情形、對大學的經驗、期望與感受

等，問卷主題和詳細內容如表三及表四所示。 

表三 『台灣高等教育資料庫』學生問卷主題一覽表 

      問卷名稱 
主題 

91 學年度 
畢業生 

92 學年度 
大一新生 

92 學年度大三 
及二技學生 

94 學年度 
大一新生 

94 學年度 
二技新生 

94 學年度 
大三學生 

基本資料 * * * * * * 

高中職生涯  *  * *  

大學生涯  *  *   

學生自我看法與

意見 
* * * * * * 

課業修習方式   *  * * 
生活作息   *  * * 
經費來源   *  * * 
未來規劃   *  * * 
對學校的看法 *  *  * * 
就業情況 *      
進修情形 *      

表四 『台灣高等教育資料庫』學生問卷內容一覽表 

      問卷主題 題  目  內  容 

基本資料 性別，身份別，族群，身高體重，父母親教育程度，父母親工作，與父母關係，

家庭年收入，家裡的成員，高三時住宿情形等 
高中職生涯 就讀學校類型，入學方式，電腦及網路使用情形，電腦能力，教師上課方式，

補習情形，學業成績，入學測驗成績，英語檢定考，擔任幹部，閱讀情形等。

大學生涯 入學方式，應屆畢業生與否，選校因素，選系因素，學習計劃，對大學生活的

期待，時間分配情形，社團參與情形，上網情形，學費及生活費來源，住宿情

形，修課因素等。 
學生自我看法與

意見 
自我興趣及能力分析，人格特質，心理適應，自我能力評估，對大學教育功能

的看法，人生目標，對目前就讀大學的滿意度等。 
課業修習方式 修習輔系、學程等經驗，教師上課及方式，教師評分方式，課程設計，選課因

素，學習情形，學習成果，社團參與情形，課程滿意度，學分修習狀況等。 
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表四 『台灣高等教育資料庫』學生問卷內容一覽表（續） 

      問卷主題 題  目  內  容 

生活作息 住宿情形，閱讀內容及形式，每天活動時間分配，上網情形，打工情形，圖書

館使用，與同儕平常討論的議題等。 
經費來源 獎學金、工讀金補助情形，學費及生活費來源等。 
未來規劃 學習計劃，進修規劃等。 
對學校的看法 人際關係，學校滿意度，學校對發展各項能力的幫助情形，對課程、科系、師

資的評價等。 
就業情況 工作狀態，工作性質，地點，時數，收入，是否與所學相關，工作能力需求狀

況，工作滿意度，找工作相關，學位證照影響就業程度，電腦程度影響就業程

度等。 
進修情形 國內外大學進修情形，進修領域，工作需求進修，進修理由等。 

「93 學年度大專院校專任教師」調查是為瞭解教授們的工作環境、教學研究狀

況、面臨的問題與壓力及大專教師對大專教育的看法與建議，蒐集的內容請參考表

五。 

表五 『台灣高等教育資料庫』專任教師問卷內容一覽表 

      問卷主題 題  目  內  容 

工作與生活情況 
擔任行政工作、兼職或導師情形，參與校外服務，每週工作時間分配，教

學工作負擔等。 

教學策略、方法及

學生評鑑方式 
使用之教學策略，教學媒體及資源的應用情形，常用的教學評分方式，設

計課程時考慮的因素。 

對學校工作環境的

滿意度 
學校設備，學校人力資源，學校制度(人事、研究進修、教學、課程)，學校

組統文化。 

對學生的看法 學生能力及特質的評價。 

對學校的整體看法 學校發展目標，領導作風，校園景觀，行政效率。 

其他 工作上的困擾與對高教政策的意見 

基本資料 
性別，出生年，婚姻狀況，配偶的教育程度，父母親的教育程度，父母親

工作，子女人數，居住情況，學歷，起任年度，首次任大專教職年度及職

等，退休情形，專任經歷。 

SRDA 開放的資料項目包括過錄編碼簿、次數分配、SPSS 資料檔、問卷及報告

書等，會員可至 SRDA 首頁（http://srda.sinica.edu.tw/）→大型學術調查→台灣高等

教育資料庫，查詢或下載已釋出之調查資料。 

參考資料與相關網站 

1. 國立台灣師範大學教育評鑑與發展研究中心台灣高等教育資料庫整合計畫

http://www.cher.ed.ntnu.edu.tw/index.php 
2. 台灣高等教育資料系統之建置及相關議題之探討(3/3)成果報告 
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台灣社會變遷基本調查 
權數使用方式 

楊惠婷 

「台灣社會變遷基本調查」（以下簡稱社會變遷）日前已釋出歷年權數資料檔，

以下針對社會變遷權數檔及加權說明的提供方式、格式與檔案名稱，以及權數計算

方式、母體資料來源、如何合併資料檔等一一說明。 

一、 各期權數檔的提供方式、格式與及檔案名稱 

社會變遷目前釋出期次為一期一次至五期二次，權數檔依權數計算相對於問卷

資料檔釋出的時間先後，而有不同的提供方式、格式及檔案名稱，可區分為兩部分

來說明： 

●一期一次至四期五次： 
問卷資料檔與權數檔各自獨立為一個檔案，也就是說有兩個資料檔，權數檔名

稱及格式如下： 

權數檔檔案名稱：weightxxxxqx.sav，如四期五次卷一，檔名為 weight0405q1.sav。 

權數檔提供格式：SPSS 系統檔，包含樣本編號及權數(變項名稱為 weight)兩欄資料。 

●五期一次、五期二次： 
權數已與問卷資料檔合併為一個檔案，檔案名稱及格式如下： 

檔案名稱：tscsxxx_vxxxx.sav，如五期一次卷一於西元 2005 年進行調查，最後確定

版本為 2007 年 11 月，SPSS 格式的資料檔檔名為 tscs051_v0711.sav。 

權數檔提供格式：問卷資料及權數在同一個檔案，權數（變項名稱為 weight）置於

全部變項的最後一欄。提供 SPSS、Stata 系統檔，及 ASCII 三種

資料格式。 

二、 加權說明的提供方式、格式與及檔案名稱 

加權說明的內容涵蓋加權變項、分組方式與各組母體人數、加權前後成功樣本

代表性檢定等資訊供使用者參考，體裁大同小異，提供 MS Word 檔案格式，主要

差別在於五期一次、五期二次以文字陳述母體資料來源及加權方式，而四期五次

（含）之前採用表列方式。加權說明檔案的名稱如下： 

●一期一次至四期五次： 
加權說明檔案名稱：weightxxxxqx.doc，如四期五次卷一，檔名為 weight0405q1.doc。 
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●五期一次、五期二次： 
檔案名稱：tscsxxxweight_vxxxx.doc，如五期一次卷一於西元 2005 年進行調查，最

後確定版本為 2006 年 9 月，則檔名為 tscs051weight_v0609.doc。 

三、 權數計算方式及使用母體 

社會變遷加權方式採「多變數反覆加權法(raking)」，依次利用母體「性別」、「年

齡」、「教育程度」及「地區層別」的各層比例來調整成功樣本的相對分佈，反覆調

整權值至成功樣本在性別、年齡、教育程度及地區層別等各層的分佈皆與母體沒有

顯著差異，即得最後的加權值。 

在使用母體方面，「性別」、「年齡」及「地區層別」採用各期次抽樣當年使用

的內政部台閩地區人口統計資料，依照母體定義加以計算；「教育程度」採用 1990
年與 2000 年兩次普查資料，假設各教育層級比例的年成長（衰減）率固定，推估

得到各期次各教育程度的人口比例。 

另外加權變項的分層方式，「性別」分為男女兩層，「年齡」大致上以 10 歲為

一層，「教育程度」分為不識字、國小、國中、高中職、五專/大學/研究所等五層，

「地區層別」則因各期次抽樣的分層方式不同而有所差異，計有地理區域、都市化

程度、人文區位資料集群分層等三種分法。詳細加權方式請參考學術調查研究資料

庫通訊第四期及第十期之介紹。 

四、 如何將問卷資料正確讀入 

四期三次（含）之前提供的問卷資料檔為純文字（ASCII）格式，搭配以 SPSS
語法撰寫的欄位定義程式，和權數檔合併之前，需要先利用欄位定義程式將問卷資

料讀入 SPSS。以下使用 SPSS 15.0 英文版示範如何利用 SPSS 程式將資料檔正確的

讀入資料。 

步驟一：先開啟**.sps 欄位定義程式，修改問卷資料檔（q1.dat）儲存路徑。 

 

 

 

 

 

 

 

在此修改資料檔儲存路徑
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開啟方式可先利用我的電腦或檔案總管檢視檔案，找到欄位定義程式之後，

直接雙擊點（double click）檔案名稱啟動 SPSS，或是先啟動 SPSS 之後，從

File→Open→Syntax，於 Open Syntax 對話框中，選取欄位定義程式開啟之。 

步驟二：執行程式，利用 Run→All 或者 ，即可將資料正確讀入。 

 

 

 

 

 

 

 

 

提醒您： 
1. 程式末端的 recode、compute 語法，若不需要時，可在指令前方加上「*」

暫不執行，或是將之刪除。 
2. 可以改變資料欄位讀取方式，得到更多資訊。 
3. 執行完畢後請至 Output 視窗，查閱是否有錯誤訊息。 

 

 

 

 

 

執行程式

* a2.1 重新編碼. 
RECODE a2.1   

(12 thru 20=1)(21 thru 30=2)(31 thru 40=3) 
        (41 thru 50=4)(51 thru 60=5)(61 thru 66=6). 
* a2.1重新編碼後之選項數值說明. 
VALUE LABLES 
    /a2.1      1"12到20年次"  

        2"21到30年次" 
              3"31到40年次" 
              4"41到50年次" 
              5"51到60年次" 
              6"61到66年次". 

若 修 改 為 「 *RECODE a2.1 」、

「*VALUE LABLES」，即不會將年齡

分組，而保留住出生年次原始資料。 
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步驟三：利用 File→Save As 可將檔案存檔備用。 

 

 

 

 

 

 

 

五、 如何將權數檔併入資料檔 

【方法一】：利用 SPSS 功能表 
步驟一：分別將問卷資料檔及權數檔的樣本編號排序， 

Data→Sort Cases→選擇排序的變項：id→OK 
 

 

 

 

 

 

 

 

*欄位定義程式. 

DATA LIST  FILE='e:\86q2.dat' FIXED RECORDS=12 TABLE  

  / id 1-5 card1 6-7 z3.1 8-9 z3.2 10-11 z4.1 12-13  
依據樣本編號結構，加入 z1 1-3 
z2 4-5，即可多得到 z1「村里編

號」和 z2「問卷編號」兩個變項。
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步驟二-1：將權數檔併入資料檔中，    步驟二-2 Browse→找出權數檔→Continue 
Data→Merge Files→Add Variables 

 

 

 

 

 

 

新增變項將按照在原檔案中的順序，依序加到已開啟檔案的後面。本範例先開

啟問卷資料檔（data.sav）再合併權值檔，權值變項將位於合併檔案的最後；反之，

合併檔案的變項依序為樣本編號、權值、問卷其他變項。 

步驟二-3 勾選 Match cases on key variables in sorted files                      

先開啟的檔案即為使用中的檔

案（Active dataset），所含變項以「*」
標示，欲併入檔案的變項以「+」標示。

SPSS 會自動比對兩個檔案的變項名

稱，將相同名稱的變項列於 Excluded 
Variable 中，供分析者選取做為合併對

應的依據，或是重新命名（Rename） 
後加入 New Active Dataset。未重覆的變項則會列於 New Active Dataset 中，如果其

中有使用者不需用到的變項，亦可將之選入 Excluded Variable，最後留在的 New 
Active Dataset 變項，即為合併後的檔案內容。 

步驟二-4 點選 id(+)放置 Key Variables→OK 

 

 

 

可依照個人需求點選是否要儲存合

併後的檔案，即完成合併步驟。 
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【方法二】：利用 SPSS 語法 

步驟一：將資料檔及權數檔的樣本編號排序 

 

步驟二：將權數檔併入資料檔中 

 

 

 

     以上權數檔合併方式是針對社會變遷一期一次至四期四次，若使用四期五

次、五期一次、五期二次之使用者，則不需進行合併步驟。 

 目前已開放使用的社會變遷調查資料大致以四期五次為分界點，後期釋出的

資料在檔案名稱及檔案格式上有較大的變動，我們瞭解這些差異可能會造成使用者

的困惑及不便，已著手規劃進行重整中，將以使用者便利為首要考量，統一資料格

式及名稱，以期提供更好的服務及資料品質。假若使用者在使用社會變遷權數檔有

任何問題或建議，歡迎提供相關訊息。 

參考資料暨相關網站： 

1. 學術調查研究資料庫通訊第四期：大型資料介紹—政治大學選舉研究中心選舉

調查，頁 16-19，民 92 年 3 月。 
2. 學術調查研究資料庫通訊第十期：台灣社會變遷基本調查權數計算方式及背景

說明，頁 30-31，民 93 年 9 月。 
3. 「學術調查研究資料庫」網站（http://srda.sinica.edu.tw/） 
4. 「台灣社會變遷基本調查」網站（http://www.ios.sinica.edu.tw/sc/） 

SORT CASES BY id (A) . 

MATCH FILES /FILE=*          
 /FILE='D:\weight0405q1.sav' 
 /BY id.                     
EXECUTE.                     
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資料庫會員申請使用狀況
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會員登入次數

資料使用狀況 
邱亦秀

會員人數 

「學術調查研究資料庫」目前的會員人數共 1,641 人，其中包括一般會員 799
人，以及臨時會員 842（有效數字至 97 年 2 月底）。 

一般會員包括：國內外公私立研究機構研究人員 79 人；國內外公私立大專院

校教師 683 人；政府機構相關研究人員 12 人；捐贈資料單位代表 8 人；調研中心

工作人員 17 人。 

臨時會員則包括了：國內外公私立大專院校大學部、碩、博士班在學學生 811
人；國內外公私立研究機構臨時性研究人員 20 人；國內外公私立大專院校臨時性

研究人員 10 人；政府機構臨時性研究人員 1 人。 

資料下載、諮詢人次及會員登入次數統計 

本資料庫會員於本資料庫網頁登入之後，可以隨時下載資料並瀏覽計畫相關文

件；若有特殊需求或該釋出資料有特殊釋出申請的限制，則須與工作人員聯絡並透

過申請的方式取得；使用者詢問有關資料釋出相關問題、檔案使用方式、程式語法

等，經由專人解答之後，即為資料庫處理的「諮詢」項目。96 年 12 至 97 年 2 月底

會員登入次數、申請下載人次及諮詢人次，如下圖： 

 

 

 

 

 

 

大型主題計畫下載人次統計（有效數字自 96 年 12 月至 97 年 2 月底） 

 台灣社會意向調查──10 人次 

 台灣社會變遷基本調查──150 人次 

 台灣地區家庭與生育力調查系列──6 人次 

 台灣選舉調查資料──21 人次 

 國民營養健康狀況變遷調查──30 人次 

 華人家庭動態資料庫──93 人次 
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會員申請程序說明 

一、 會員資格 

（一）一般會員 
1. 國內外公私立研究機構研究人員； 
2. 國內外公私立大專院校教師； 
3. 政府機構相關研究人員； 
4. 捐贈或授權資料予「學術調查研究資料庫」之個人或單位代表。 

（二）臨時會員 
1. 國內外公私立大專院校大學部、碩、博士班在學學生； 
2. 國內外公私立研究機構臨時性研究人員； 
3. 國內外公私立大專院校臨時性研究人員； 
4. 政府機構臨時性研究人員。 

二、 會員福利 

1. 線上資料下載；  
2. 線上瀏覽報告書、問卷、次數分配；  
3. 定期寄贈「學術調查研究資料庫通訊」；  
4. 電子報服務；  
5. 調查資料整理與檢誤諮詢服務；  
6. 各項網頁功能。  

三、 加入方式 

（一）上網登錄 

請至本資料庫網頁「會員專區」讀取「會員約定條款」並填寫申請表，送出

資料後將螢幕上顯示的個人資料表列印出來，在劃線處簽名以示同意該條款中的

各項規定，並請將該份書面資料以郵遞方式擲回本中心存查。  
■ 提供文件：在職（在學）文件影本。 

■ 審核時間：收到文件後一至三個工作天。 

（二）親自申請 

  親至本資料庫辦公室填寫申請表格，交付相關文件並簽署同意會員約定條款。 
■ 提供文件：在職（在學）文件影本。 
■ 審核時間：視申請人身份而定，符合者可以立即生效。 

 
四、資格認證 

（一）一般會員：會員有效期間為期兩年，以成功加入會員日起計算。本資料庫將
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每兩年主動校對會員資料，若會員未於校正期間內確認資料異動情況，則將

先暫停其會員權限。  

（二）臨時會員：會員有效期間為期一年，以成功加入會員日起計算。如仍符合臨

時會員身份資格者，應每年於期限前主動提出證明文件，得延長使用期限一

年。 

五、會員義務 

  資料庫在努力提供更好服務的同時，亦需要了解會員們的意見。因此有一些需

履行之義務項目，請會員配合實行。 

（一）資料使用：敬請遵守「會員約定條款」的各項規定。 
（二）著作回覆：會員在下載資料使用後，發表相關篇章論著等，敬請提供書目資

料，嘉惠他人作為研究方向的輔助參考之用。若能提供作品全文亦非常歡迎。 
（三）意見調查  

1. 當次：會員於下載資料三週後，資料庫會主動針對會員下載記錄詢問該次下

載之資料用途，以及資料的使用滿意度；  
2. 年度：針對會員一年來的使用情形，本資料庫將進行例行性的年度整體滿意

度調查，以作為資料庫發展及改善的參考。  
 

資料捐贈說明 
 

本資料庫亦歡迎學者及各界捐贈資料！為使這些得來不易的珍貴資料發揮最

大效用，本資料庫工作人員會謹慎處理每筆捐贈資料，並負起妥善保管之責。我們

蒐集的資料主要是以調查方法進行的量化資料，公開釋出前，我們會先瞭解該筆資

料之智慧財產權歸屬，並取得所有權人/機構同意授權本資料庫公開學術使用。 

本資料庫對資料捐贈者提供以下服務項目： 
1. 定期／不定期寄贈「學術調查研究資料庫」出版品； 
2. 資料整理與檢誤相關諮詢服務； 
3. 提供其捐贈資料之申請情況； 
4. 提供資料使用者利用其捐贈資料發表之衍生著作。 

若您願意捐贈資料給「學術調查研究資料庫」蒐藏並對外開放，或有任何疑問，

歡迎洽詢「中央研究院調查研究專題中心」資料組，我們將竭誠為您服務。 
 
電話：(02)27884188 分機 201，資料組組長王文心小姐。 
E-mail: srda@gate.sinica.edu.tw 
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徵稿啟事 

「『學術調查研究資料庫』通訊」為中央研究院人文社會科學研究中心調查研

究專題中心出版以服務學術界之刊物，每年三月、六月、九月及十二月以季刊形式

發行。本中心為增加本通訊內容之多樣性及促進與讀者的互動交流，歡迎學界人士

能夠提供以下相關議題之文章。 
一、 二手資料之利用與分析 
二、 調查資料之整理與檢誤 
三、 國內外資料庫使用之經驗 
四、 資料編碼或編碼簿之製作 
五、 統計軟體之運用 

寫作重點請著重於經驗交流與心得建議。請以 e-mail 的方式傳寄給我們，字數

以 1000-1500 字為限，並以單篇完結之形式寫作。來稿由編輯委員會審閱決定刊登

與否，一經採用將稿費酬謝，每千字 750 元。對接受刊登稿件，本刊編輯群有權刪

改並置放於「『學術調查研究資料庫』通訊」電子版網站，如不同意者，請於稿件

上聲明。文稿內容不代表本刊意見，如涉及著作權或其他文責問題，由作者自負法

律責任。文章以真實姓名發表，投稿請附上您的聯絡方法（通訊地址與電話）。 

『學術調查研究資料庫』通訊 
Survey Research Data Archive Newsletter 
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